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Important Information
Except as otherwise expressly stated in the License that accompanies a 
program, Texas Instruments makes no warranty, either express or 
implied, including but not limited to any implied warranties of 
merchantability and fitness for a particular purpose, regarding any 
programs or book materials and makes such materials available solely on 
an "as-is" basis. In no event shall Texas Instruments be liable to anyone 
for special, collateral, incidental, or consequential damages in connection 
with or arising out of the purchase or use of these materials, and the sole 
and exclusive liability of Texas Instruments, regardless of the form of 
action, shall not exceed the amount set forth in the license for the 
program. Moreover, Texas Instruments shall not be liable for any claim of 
any kind whatsoever against the use of these materials by any other 
party.

FCC Statement
Note: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one or 
more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from 
that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

© 2011 Texas Instruments Incorporated
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Getting started with the TI-Nspire™ CX 
handheld

The TI-Nspire™ CX handheld and the TI-Nspire™ CX CAS handheld are 
the newest handhelds in the TI-Nspire™ family of products. Featuring a 
backlit color display and a slimmer form, the handhelds provide 
touchpad navigation, dynamic graphing, and interactive computer 
features.

The handhelds and the TI-Nspire™ software share the same functionality, 
enabling you to transfer class assignments from the handheld to the 
computer or transfer documents to the handheld when you need to be 
mobile. Start assignments at school, then finish the work at home to take 
advantage of the software’s full-color display and easy-to-use navigation. 
Use the software to download the latest software and handheld 
operating system updates as they become available to ensure you have 
the latest enhancements.

This guide covers both the TI-Nspire™ CX handheld and the TI-Nspire™ 
CX CAS handheld. While they operate identically in many ways, there are 
a few distinctions. If the TI-Nspire™ CX CAS handheld has additional 
functionality, it is pointed out and the CAS operation is described.

About CAS
With CAS, or the Computer Algebra System, you can: 

• Perform both symbolic and numeric calculations. 

• Factor and expand expressions and solve for common denominators.

TI-Nspire™ CAS technology makes it possible to recognize, simplify, and 
calculate math expressions, preserving the symbols including variables 
and terms such as “e” and p.

This ability to enter and view equations and expressions on screen as they 
appear in textbooks is especially useful for step-by-step, arithmetic, 
algebraic, and calculus calculations.
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TI-Nspire™ CX handheld keys

Use the TI-Nspire™ 
Touchpad as you 
would a laptop 
touchpad. You can also 
press the outer edges 
to move right, left, up, 
and down.

e Moves to the 
next entry field.

/ Provides access 
to the function or 
character shown 
above each key. Also 
enables shortcuts in 
combination with 
other keys.

c Turns on the 
handheld. If the 
handheld is on, this 
key displays the home 
screen.

~ Opens the 
Document menu.

· Evaluates an 
expression, 
executes an 
instruction, or 
selects a menu 
item.

g Makes the 
next character typed 
upper-case.

. Deletes the 
previous character.

» Opens the 
Scratchpad for 
performing quick 
calculations and 
graphing.

d Removes menus 
or dialog boxes from 
the screen. Also stops 
a calculation in 
progress.

h Displays 
stored variables.

b Displays the 
application or 
context menu.

Note: A ¢ symbol on a key indicates access to multiple options. To access an 
option, press º repeatedly or use the arrow keys on the touchpad. Press 
· or click to select the option.
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Preparing the TI-Nspire™ CX handheld for use
The TI-Nspire™ CX handheld comes equipped with an Li-ion 
rechargeable battery. Like a cell phone or other similar device, charge the 
battery for at least four hours to ensure optimum performance. The 
handheld also comes with the following accessories:

• Standard mini-B to mini-B USB cable for transferring files to another 
handheld

• Standard A to mini-B USB cable for transferring files to and from a 
computer and for charging the battery

Charging the handheld
Use one of the following options to charge the battery in the TI-Nspire™ 
CX handheld:

• Connect the handheld to a computer using a standard A to mini-B 
USB cable. If the driver is not found when the handheld is connected 
to the computer, insert the CD to install the correct driver. To 
download software that includes a driver, go to 
education.ti.com/software.

• Connect to a wall outlet using a TI wall adapter (sold separately in 
Europe and Asia). 

• Place the handheld or multiple handhelds in a TI-Nspire™ CX Docking 
Station or TI-Nspire™ Docking Station.

Note: For more information about recharging batteries, see Configuring 
the TI-Nspire™ CX handheld.

Turning on the TI-Nspire™ handheld for the first 
time

After charging the battery, press c to turn on the handheld.

A progress bar is displayed while the operating system loads. Next, 
choose preferences for language and font size when prompted.

Note: To turn the handheld off, press / c. The settings and 
memory contents are retained.
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Using Automatic Power Down™ 
To prolong battery life, the Automatic Power Down™ (APD™) feature 
turns off the handheld after three minutes of inactivity. When this 
happens, press c to turn the handheld on and return to the last 
document or last menu accessed. To change the default setting, press 
c 5 3 to access the Handheld Setup screen where you can change 
the Power Standby setting.

Note: For more information about setting up the handheld, see 
Configuring the TI-Nspire™ CX handheld.

Choosing a language
After the OS is loaded, select a preferred language.

1. Press ¢ to open the drop-down menu.

2. Press 6 to scroll through the languages, then press x or ·  to 
select a language.

3. Press e to highlight the OK button, then press x or · to save 
the language selection.

Choosing a font size
Next, select a font size for the display.

1. Press ¢ to open the drop-down menu.

2. Press 6 to highlight the font size, then press x or · to select it.
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3. Press e to highlight the OK button, then press x or ·  to open 
the Welcome! screen.

4. To continue, press x or · to select OK and open the Home 
screen. 

Adjusting the brightness of the backlighting
The screen on the TI-Nspire™ CX handheld is backlit making it easier to 
use in all lighting conditions. By default, the brightness setting is 
medium. To adjust the backlight brightness:

• Dimmer: Press and hold / and tap -.

• Brighter: Press / and tap +.

Using the TI-Nspire™ Touchpad
Use the Touchpad to navigate or complete any task that can be 
completed using the arrow and Enter keys. Use the touchpad to navigate 
in two ways: 

• Use it like a computer touchpad by moving your fingertip in a sliding 
motion on the center area of the touchpad to activate and move the 
mouse pointer. Click or tap the center of the Touchpad to select a 
menu option or complete an action. 
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• Press the arrow keys on the outside edge of the Touchpad to nudge 
the mouse pointer up, down, left, or right, then click e x or 

press · to complete an action. 

If you hold down an arrow key, the mouse pointer continues to move 
in that direction.

Note: If the mouse pointer is visible on a command or file, click or 
tap x in the center of the touchpad to select that command or file. If 
the command or file is highlighted, move the pointer over that item or 
press · to select it.

When working in an application, use the touchpad to access more 
information about problems. For example, hovering over a Graphs & 
Geometry object displays information about variables used in that object 
and about tools that are available.

Some users prefer to customize their touchpad settings; to speed up or 
slow down their pointer, or to enable tap to click. To change the default 
settings for the touchpad, see Configuring the TI-Nspire™ CX handheld.

Understanding the Scratchpad
Use the Scratchpad to make quick calculations and graphs without 
affecting the current TI-Nspire™ document. For example, when you need 
a quick way to test a calculation before you add it to a document, you 
can open the Scratchpad application and perform the calculation. Then, 
you can either discard the calculation or add it to a document. For more 
information about the Scratchpad, please see Using the Scratchpad.

Using the Home screen
The Home screen provides a starting point for all activities performed on 
a handheld:

• Opening the scratchpad for quick calculations and graphing

• Creating new documents

• Opening and managing existing documents

• Opening the scratchpad for quick calculations and graphing

• Defining settings and viewing status

• Viewing hints for operating the handheld

• Accessing recent documents

• Returning to the current document
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Note: To return to the Home screen from any other location, press c.

Home screen options

Menu Option Purpose

Scratchpad

Use the Scratchpad menu options to open a Calculator or Graph 
application without affecting your document.

While in Scratchpad, press » to toggle between Scratchpad 
applications: Calculate and Graph.

Calculate Opens the Scratchpad with a Calculator application 
active. From the Home screen, type A.

Graph Opens the Scratchpad with a Graph application 
active. From the Home screen, type B.

Documents

To select options for working with documents, press the associated 
number or use the Touchpad to select an icon then press x or ·.

New 
Document

Opens a new TI-Nspire™ document with available 
applications listed.

My 
Documents

Opens the file browser where you can open existing 
TI-Nspire™ documents or send files to others.

Recent Lists the five most recently saved documents.

Current Goes to the document that is currently open.

Settings Check the status of the handheld and change 
settings.

Application icons

To add a new page to the current document, select an application 
icon. If no document is open, a new document opens with the 
selected application on a new page.

Calculator Adds a page to a document for entering and 
evaluating math expressions.
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To learn more about applications and documents, see the Working with 
Documents on the TI-Nspire™ handhelds.

The TI-Nspire™ handheld screen
The icons on the handheld screen provide information about the status 
of handheld operations and provide an easy way to access and change 
settings. This screen shows the icons, which are described below.

Graphs Adds a page for graphing and exploring functions.

Geometry Adds a page for creating and exploring geometric 
shapes.

Lists & 
Spreadsheet

Adds a page for working with data in tables.

Data & 
Statistics

Adds a page and provides tools used to visualize 
sets of data in different types of plots and provides 
tools for manipulating data sets to explore 
relationships between the sets of data.

Notes Provides text editing functions for adding text to 
TI-Nspire™ documents for use as notes or to share 
with other users.

Vernier 
DataQuest™

Adds a page for collecting and analyzing data from 
sensors or probes.

Menu Option Purpose
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Icon Function

À 3 4 Page scrolling arrows - Use the touchpad and these 
arrows to scroll through the pages in a document.

Á Page tabs - Indicate the problem number followed by 
the page number. If problems are named, move the 
touchpad pointer over the tab to view the page name.

Â Document name - Shows the current document name. 
Click here to access the Documents menu. An asterisk by 
the document name indicates changes were made since 
the document was last saved.

Ã Press to Test - Indicates that the handheld is in Press-to-
Test mode.

Ä Login status - Shows whether the handheld is searching 
for an access point (blinking), found an access point 
(solid), not communicating, connected and ready to log 
in (a blinking arrow), or logged in and charged (a solid 
arrow). Click here to view Settings & Status.

Å g, /, or Ê status

À

Á Â Ã Ä

Å

Æ ÇÀ
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Using Hints
Hints are quick tips available throughout the software on the handheld. 
There are several easy ways to access Hints:

• Press / μ.

• Some dialog boxes contain a question mark icon. Click this icon to 
open Hints for that task.

To scroll through the Hints, use the touchpad or arrow keys:

– To page down, press / 3.

– To page up, press / 9.

– To go to the end of the Hints file, press / 1.

– To go back to the beginning of the file, press / 7.

Æ Settings & status - Shows the level of the battery 
supply. Click here to change settings.

Ç Close document - Click here to close the current 
document. If information is unsaved, save or discard 
when prompted.

Icon Function
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Using the Scratchpad

The Scratchpad is a feature of the TI-Nspire™ handheld that lets you 
quickly:

• Evaluate math expressions.

• Graph functions.

Opening and closing the Scratchpad

From the Home screen, press » to open the Scratchpad.

The first time you open the Scratchpad, a blank page opens with the 
Calculator active.

Press » to alternate between the Calculate and Graph pages.
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Press b to see the Scratchpad Calculate or Scratchpad Graph menu. 
These menus are subsets of the TI-Nspire™ menus for the Calculator 
and Graphs & Geometry applications. For complete listings of those 
menus, refer to the documentation for those applications.

Press d to close the Scratchpad.

Calculating with the Scratchpad
From the Scratchpad Calculate page, enter a math expression on the 
entry line, then press · to evaluate the expression. Expressions display 
in standard mathematical notation as you enter them.

Each evaluated expression and result becomes part of the Scratchpad 
history, displayed above the entry line. 

Entering simple math expressions

Note: To enter a negative number, press v and then enter the number.

Suppose you want to evaluate  

1. Select the entry line in the work area.

2. Type 2 l 8 to begin the expression.

3. Press ¢ to return the cursor to the baseline, and then complete the 
expression by typing:
r 43 p 12

4. Press · to evaluate the expression.

The expression displays in standard mathematical notation, and the 
result displays on the right side of the page.

Note: You can force a decimal approximation in a result by pressing 

/ · instead of ·.
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Note: Results formatting can also be adjusted in Settings. See Working 
with documents on the TI-Nspire™ handheld for more information about 
Settings.

Inserting items from the Catalog
You can use the Catalog to insert functions and commands, units, 
symbols, and expression templates into the entry line.

1. Press k to open the Catalog. By default, the first tab is displayed, 
which lists all commands and functions in alphabetical order.

Pressing / · forces the approximate 
result.

Catalog 
for a non-
CAS 
handheld
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2. If the function you are inserting is visible in the list, select it and press 

· to insert it.

3. If the function is not visible:

a) Press a letter key to jump to the entries that begin with that letter.

b) Press ¤ or £ as necessary to highlight the item you are inserting.

c) Click a numbered tab to list functions by category: math functions, 
symbols, math templates, library objects, and value for standard 
measurement units (CAS).

d) Press · to insert the item into the entry line.

Using an expression template
Templates help you enter matrices, piecewise functions, systems of 
equations, integrals, derivatives, products, and other math expressions.

For example, suppose you want to evaluate 

1. Press t to open the Template palette.

2. Select  to insert the algebraic sum template. 
The template appears on the entry line with small blocks representing 
elements that you can enter. A cursor appears next to one of the 
elements to show that you can type a value for that element.

Catalog for 
a CAS 
handheld
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3. Use the arrow keys to move the cursor to each element’s position, and 
type a value or expression for each element.

4. Press · to evaluate the expression.

Inserting expressions using a wizard
You can use a wizard to simplify entering some expressions. The wizard 
contains labeled boxes to help you enter the arguments in the 
expression.

For example, suppose you want to fit a y=mx+b linear regression model 
to the following two lists:

{1,2,3,4,5}
{5,8,11,14,17}

1. Press k 1 to open the Catalog and show the alphabetic list of 
functions.

2. Click inside the list, and then press L to jump to the entries that 
begin with “L.”

3. Press ¤ as necessary to highlight LinRegMx.

4. If the Wizards On option is not checked: Press e e to highlight 

Wizards On, press · to change the setting, then press e e to 
highlight LinRegMx again.
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5. Press ·.

A wizard opens, giving you a labeled box to type each argument.

6. Type {1,2,3,4,5} as X List.

LinRegMx 
function in a 
non-CAS 
handheld

LinRegMx 
function in a 
CAS 
handheld
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7. Press e to move to the Y List box.

8. Type {5,8,11,14,17} as Y List.

9. If you want to store the regression equation in a specific variable, 
press e, and then replace Save RegEqn To with the name of the 
variable.

10. Select OK to close the wizard and insert the expression into the entry 
line.

The expression is inserted along with statements to copy the 
regression equation and display the variable stat.results, which will 
contain the results.

LinRegMx {1,2,3,4,5},{5,8,11,14,17},1: CopyVar stat.RegEqn,f1: 
stat.results

The Scratchpad then displays the stat.results variables.

Note: You can copy values from the stat.results variables and paste 
them into the entry line.

Viewing the history
Each evaluated expression and result becomes part of the Scratchpad 
history, displayed above the entry line. 

Press £ or ¤ to scroll through the history.
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À Current entry/total entries

Copying a history item to the entry line
You can quickly copy an expression, subexpression, or result from the 
history into the entry line.

1. Press £ or ¤ to move through the history and select the item that 
you want to copy.

2. Optionally, select part of the expression or result by using Shift in 
combination with the arrow keys.

3. Press · to copy the selection and insert it into the entry line.

reuseExpr02.noncas.gif

Clearing the history
When you clear the history, all variables and functions defined in the 
history retain their current values. If you clear the history by mistake, use 
the undo feature.

From the Actions menu, select Clear History.
(Press b 1 5.)

À
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All expressions and results are removed from the history.

Editing Scratchpad expressions
Although you cannot edit a Scratchpad Calculate expression in the 
history, you can copy all or part of an expression from the history and 
paste it to the entry line. You can then edit the entry line.

Inserting elements into the entry line

1. Press e, ¡, ¢, £, or ¤ to position the cursor in the expression. The 
cursor moves to the closest valid position in the direction that you 
press.

2. Type the elements or insert them from the Catalog.

Selecting part of an expression
You can delete, cut, or copy a selected part of an expression.

1. Press ¡, ¢, £, or ¤ to move the cursor to a starting point in the 
expression.

2. Press and hold g and press ¡, ¢, £, or ¤ to select.

– To delete the selection, press ..

– To cut the selection to the Clipboard, press / X.

– To copy the selection to the Clipboard, press / C.

– To paste the selection to a new entry line in Scratchpad, press 
/ V.

Graphing with the Scratchpad

From the Scratchpad Graph page, click the Entry Line Expand button  
to display the entry line and type an expression to graph. The entry line 
displays the required format for typing a function. The default graph 
type is Function, so the form f1(x)= displays. 

1. Choose Graph Type from the menu, and select a graph type.

For example,

• To graph a scatter plot, press b 3 4. Click var to choose 
variable to plot as x and y for sn.
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• To graph a function, press b 3 1.

The entry line changes to display the expression format for the 
specified graph type. You can specify multiple functions of each 
graph type.

2. Type an expression and any other parameters required for the graph 
type.

3. Press · to graph the function, or press ¤ to add another function. 

If necessary, you can use press b 4 to choose a tool on the 
Window/Zoom menu and adjust the viewing area.

When you graph the expression, the entry line disappears to show an 
uncluttered view of the graph. If you select or trace a function, that 
function displays on the entry line. You can change a function by 
editing its expression or grabbing and changing the graph.

As you graph multiple functions on the axes, the label containing the 
expression displays for each. You can define and graph a maximum of 
99 functions of each type. 

4. Use the b key to explore and analyze the graphed function by 
tracing it, finding points of interest, or assigning a variable in the 
expression to a slider. 

Viewing the function table

To display a table of values for the current function, press b 2 5.

To hide the function table, click the graph and then press b 2 5. 
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Changing the appearance of the axes
As you work with graphs, the Cartesian axes are displayed by default. 
You can change the appearance of the axes in the following ways:

1. Press b 4 and choose the Zoom tool to use. 

2. Select the axes and press / b 3 to activate the Attributes tool.

a) Press 9 or : to move to the attribute to change. For example, 
choose the end style attribute.

b) Press 7 or 8 to choose the style to apply. 

c) Change any other attributes of the axes as required for your work, 
then press d to exit the attributes tool.

3. Adjust the axes scale and tic mark spacing manually. 

a) Click and hold one tick mark, and move it on the axis. The spacing 
and number of tic marks increases (or decreases) on both axes.

b) To adjust the scale and tic mark spacing on a single axis, press and 
hold g, and then grab and drag a tic mark on that axis.

4. Change axis end values by double-clicking them and typing new 
values.

5. Adjust the location of the axes. To move the existing axes without 
resizing or rescaling them, click in and drag an empty region of the 
screen until the axes are in the desired location. 

6. Change the axes’ scales by pressing b 4 1. 

Type the values of your choice over the current values for x-min, 
x-max, y-min, and y-max and click OK. 

7. Press b 2 1 to hide or show the axes.

• If the axes are shown on the page, selecting this tool hides them.

• If the axes are hidden on the page, selecting this tool redisplays 
them.

Tracing a graphed function
Graph Trace moves through the points of a graphed function, 
parametric, polar, sequence, or scatter plot. To enable the trace tool:

1. Press b 5 1 to move across the points in a graphed function in 
Trace model.
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2. (Optional) To change the step increment for tracing, press 

b 5 3.

After you type a different step increment, the Graph Trace tool moves 
across the graph in steps of that size, instead of moving at the default 
step automatically defined with a function.

3. Use Graph Trace to explore a graphed function in the following ways: 

• Move to a point and hover to move the trace cursor to that point.

• Press 7 or 8 to move from point to point on the function’s graph. 
The coordinates of each point traced displays.

• Press 9 or : to move from one function’s graph to another, or to a 
scatter plot. The point’s coordinates update to reflect the new 
location of the trace. The trace cursor is positioned on the point of 
the new graph or plot with the closest x value to the last point 
identified on the previously traced function or graph. You can 
trace multiple functions as described in Tracing all graphs.

• Type a number and press · to move the trace cursor to that 
value on the function’s graph. 

• Create a persistent point that remains on the graph while in 
Graph Trace mode by pressing · when the trace point reaches 
the point you want to label.

• Trace through and identify the points at which the function has 
no defined x or y value (a discontinuity). The string undef displays 
instead of a value when you move over a point that is not defined 
for the function.

Notes: 
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• When you select or trace a function on the work area, that 
function displays on the Edit Line.

• When you trace beyond the initially visible graph, the screen pans 
to show the area being traced.

4. Exit Graph Trace by pressing d or by choosing another tool.

Finding points of interest
You can use the tools on the Analyze Graph menu to find a point of 
interest in a specified range of any graphed function. Choose a tool to 
find zero, the minimum or maximum, the point of intersection or 
inflection, or the numeric derivative (dy/dx) or Integral on the graph. 

1. Select the point of interest that you want to find on the Analyze 

Graph menu. For example, to find a zero, press b 6 1.

The icon for the selected tool displays at the top left on the work 
area. Point to the icon to view a tooltip about how to use the selected 
tool. 

2. Click the graph you want to search for the point of interest, then click 
a second time to indicate where to start the search for the point. 

The second click marks the lower bound of the search region and a 
dotted line displays.

Note: If you are finding the derivative (dy/dx), click the graph at the 
point (numeric value) to use for finding the derivative.

3. Press 3 or 4 to move the dotted line that marks the search region, then 
click the point at which you want to stop the search (upper bound of 
the search region). 

SPG_POI.gif
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4. Press · at the point to start the search. The tool shades the range. 

If the search region you specified includes the point of interest, a 
label for the point displays. If you change a graph that has points of 
interest identified, be sure to check for changes in points of interest. 
For example, if you edit the function on the entry line or manipulate 
a plot, the point where the graph intersects zero can change. 

The labeled points of interest remain visible on the graph. You can 
exit the tool by pressing d or choosing another tool. 

Working with variables in the Scratchpad
Scratchpad variables are shared between Scratchpad Calculate and 
Scratchpad Graph, but not with any TI-Nspire™ documents. If you use the 
same name for a Scratchpad variable and a variable in a document, no 
conflict occurs unless you attempt to copy expressions between 
documents and the Scratchpad.

Saving the Scratchpad contents
You can save the Scratchpad Calculate page, the Scratchpad Graph page, 
or both as a TI-Nspire™ document.

1. Press ~, then select Save to Document.

2. Press ·.
The Save to Document dialog box opens.

3. Select the page or pages to save.

4. If a document is open, select either New or Current document.

5. Click Save.

• If you selected to save to an open document, the Scratchpad 
pages are added to the document.
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• If you selected to save to a new document:

– Click Yes when the Save dialog box opens.

– Type a name for the document.

– Click Save to save the new document.

Clearing Scratchpad contents
Complete the following steps to delete the calculations and graphing 
work from the Scratchpad application.

1. Press ~, then select Clear Scratchpad.

2. Press · to delete the Scratchpad contents.
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Working with documents on the CX 
handheld

All of the work you do with the TI-Nspire™ CX handheld is contained in 
one or more TI-Nspire™ documents, which you can share with other 
handheld users and with those using the computer software.

• Each document is divided into at least one, and up to 30, problems.

• Each problem contains at least one, and up to 50, pages.

• Each page can be divided into as many as four work areas. 

• Each work area can contain any of the TI-Nspire™ applications 
(Calculator, Graph, Geometry, Lists & Spreadsheet, Data & Statistics, 
Notes, and Vernier® DataQuest).

Opening a document

1. From the Home screen, select My Documents or press 2. The file 
manager opens.

2. Navigate to the file you want to open. 

• Press ¤ to higlight the document name, then press x or · to 
open the document.

• If the file is in a folder, press ¤ to highlight the folder, then press 

x or · to open the folder.

3. Press ~ to open the Documents menu to access options for 
working with the open document.
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Creating a new document

1. From the Home screen, select New Document or press 1. You can 

also press / N.

A new document opens with a list of applications. 

Note: The tab at the top left of the screen indicates that this is the 
first page of the first problem.

2. Use ¤ and £ to highlight the application you want to add to the 

page, then press · to open the page.

Saving a document
To save the document:

1. Press ~ to open the Documents menu, then select File > Save. 

Note: You can also press ~ 1 4 or / S to save a document. To 

save the document to another folder, press ~ 1 5.

If you are saving the document for the first time, you will be asked 
which folder to save it to, and what to name the document. The 
default folder is My Documents.
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2. Type a name for the document.

3. To save the document in a different folder:

a) Press g e to navigate to the list of existing folders. The first 
folder in the list is selected.

b) Use the ¤ and £ to scroll through the list of folders. 

c) To select and open a folder, press x.

• To save the document in a new folder:

a) Press e until the New Folder icon is highlighted, then 

press · to create a new folder. By default, the folder 
name is "Folder1."

b) Type a name for the new folder, then press · to save.

c) Press · again to open the folder. The File Name field becomes 
active.

d) Type a name for the document.

4. Tab to the Save button and press · to save the document.

new folder 
icon

Type new 
folder name
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Working with applications
Options for working with applications include:

• Creating a new document and selecting an application

• Adding a new page and application to an open document

• Adding multiple applications to a page in a document 

Adding an application
There are multiple ways to add an application to a page:

• When creating a new document, use the Touchpad or corresponding 
numbers to select an application from the list of applications.

• To add a new page and application to an open document, press 
/ ~, then select an application from the list.

For example, press 2 to add the Graph application to the page. The 
application opens in the work area.

You can also press c, then select an application from the Home 
screen by clicking one of the following application icons:

Calculator

Graphs

Geometry

Lists & Spreadsheet
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Using multiple applications on a page
You can add up to four applications to each page.

When you create a new document, it contains space to add one 
application. If you need to add more than one application to a page, you 
can change the layout to accommodate as many as four applications.

You can choose a standard layout, provided as a menu item, or you can 
customize a layout to suit your needs.

Choosing a standard page layout

1. Press ~ 5 2 to display layout options.

2. Press the number that corresponds to the layout you want. 

For example, press 2 to create a two-pane layout, divided vertically 
on the page. 

Data & Statistics

Notes

Vernier DataQuest™
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3. Press / e to move between panes. Bold lines around the pane 
indicate that the pane is active.

4. Press b, then press the number of the application you want to add 

the new pane. For example, press 4 to add the Lists & Spreadsheet 
application.

 

Note: If you need to change the layout of the page to add or delete 
applications, you can do so at any time. Make sure to first select the 
application you want to delete.

Creating a custom page layout
If the standard layouts do not meet your needs, you can customize the 
space allotted to applications on a page. 

1. Press ~ 5 2 to display layout options.
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2. Press 1 to select the custom split option.

The standard layout displays, with a blinking divider between the 
application panes.

3. Press £, ¤, ¡ or ¢ to move the divider to adjust the height or width 
of the panes in the layout.

4. Press + or - to select a defined layout:

• Pressing - returns to a full page layout.

• Pressing + once switches layout from a vertical layout to a 

horizontal layout. Press - to go back to a vertical layout.

• Pressing + twice adds a third pane to the page. Pressing + 
multiple times enables you to choose between a vertical and 
horizontal page layout with three panes.

• Pressing + five times adds a fourth pane to the page. Press - to 
cycle through the previous layout options.

5. Press x or · to accept the layout dimensions.
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6. To select a pane, use the Touchpad to move your pointer and click 
inside the pane to make it active, then you can select an application.

Swapping applications on a page
If you want to change the position of applications on a page with 
multiple applications, you can do so by “swapping“ the positions of two 
applications.

1. Press ~ 5 Page Layout 4 Swap Application.

The selected application is surrounded by a heavy, flashing black 
border, and the Swap App cursor é displays on the screen.

Note: On a two-pane page layout, the selected application 
automatically swaps position with the opposite pane. Press x  

or · to complete the swap.

2. Press £, ¤, ¡ or ¢ to position the cursor over the application you are 
targeting to swap. 

3. Press x or · to complete the swap.

Note: Press d to cancel the swap.

Grouping applications
To group up to four application pages into a single page:

1. Select the first page in the series.

2. From the Document menu, select Page Layout > Group.

Press ~ 5 7.

The next page is grouped with the first page. The page layout 
automatically adjusts to display all the pages in the group.

Ungrouping pages
To ungroup the pages:

1. Select the grouped page.

2. From the Document menu, select Page Layout > Ungroup.

Press ~ 5 8.

The material becomes individual pages for each application.

Deleting an application from a page
1. Click the application you want to delete. 

2. From the Document menu, select Page Layout > Delete Application.
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Press ~ 5 5.

The selected application is deleted.

If you want to undo the delete, type Ctrl-Z.

Using the Application menu 
The Application menu enables you to select tools for working with a 
specific application. Each application has a unique menu. 

Using the Application menu

1. From a blank page, press b to display the Application menu. The 
menu displays applications that you can add to the page.

2. Press the number of the application you want to add to the page. For 

example, press 4 to add the Lists & Spreadsheet application.

3. Press b to display the Application menu, which lists the options for 
working with the current application.
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The example below displays the Application menu for the Lists & 
Spreadsheet application.

Context menus
Context menus display options that are specific to the selected object or 
the current cursor location. 

Using the Context menu
To access a context-sensitive menu from an application, press 
/ b.

In the example below, the context menu displays options available for 
the selected cell in Lists & Spreadsheet.

 

Working with problems and pages
The options on the Documents menu enable you to:

• Save a document

• Access edit functions such as undo, redo, cut, copy, paste, and delete
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• Move between pages and open the page sorter view for documents 
with multiple pages

• Modify page layout, insert pages or problems, delete pages, and 
change settings

• Add problems, pages, and applications to open documents

• Access page layout options

Adding a problem to a document
Adding problems to a document enables you to reuse variable names. A 
document can contain as many as 30 problems. To add a new problem:

1. Press ~ 4 1 to open the Insert options.

A new problem with one page is added to the document. The tab at 
the top left of the screen indicates that this is the first page of the 
second problem. 

2. Press b to open the Application menu, then press the number 
corresponding to the application you want to add to the new page. 
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Viewing and reordering pages in a document
The Page Sorter displays all of the problems in your document and all 
pages within each problem in thumbnail format. You can use the Page 
Sorter to rearrange and delete pages, copy a page from one problem and 
paste it into another, and apply templates to pages.

Viewing multiple pages with the Page Sorter
Although the handheld typically displays the pages in your document 
one at a time, the Page Sorter lets you see all of the problems in your 
document and all pages within each problem in thumbnail format. You 
can use the Page Sorter to rearrange and delete pages, and copy a page 
from one problem and paste it in another.

Opening the Page Sorter from a document

Press / £.

The Page Sorter screen displays all of the problems and pages in the 
current document.

Reordering pages in a problem

Use the Page Sorter (press / £) to move a page within a problem with 
multiple pages:

1. Press the 3 or 4 key to select the page you want to move.

A heavy border around the page indicates that it is selected.
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2. Either press and hold x or press / x until the grab cursor ÷ 
displays. 

3. Press 3 , 4,  5 or 6 to move the page to the desired position.

4. Press x or · to finish the move.

Note: You can press d to cancel.

The page moves to the new location within the problem, and the 
counter adjusts accordingly.

Copying a page to another problem
To copy a page from one problem to another in the same document:

1. Press / £ to open Page Sorter.

2. Press 3 , 4,  5 or 6 to select the page you want to copy.

A heavy border around the page indicates that it is selected.

3. Press / C to copy the page.
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4. Press 3 , 4,  5 or 6 to select the desired position in the problem where 
you will paste the page. The copied page will be placed after the 
page you select.

5. Press / V to paste the page in the new location.

The page is copied to the new location within the problem, and the 
counter adjusts accordingly.

Note: If the page contains variables with the same names as the new 
problem, a conflict may occur. Rename the variables if necessary.

Copying a page to another document
To copy a page from one document to another document:

1. Press / £ to open the Page Sorter.

2. Press 3 , 4,  5 or 6 to select the page you want to copy.

A heavy border around the page indicates that it is selected.

3. Press / C to copy the page.

4. Press c 2 to open My Documents.

5. Press 5 and 6 to highlight the folder containing the document you 
want to copy the page to. 

6. Press 4 to open the folder, or press b 3.

7. Press the 5 and 6 keys to highlight the document. 

8. Press x or · to open the document.o

9. Press / 5 to display the Page Sorter.

10. Press 3 , 4,  5 or 6 to move the page to the desired position in the 
document. 

11. Press / V to paste the page in the new location.

The page moves to the new location within the problem, and the 
counter adjusts accordingly.

Copying, pasting, and deleting problems
You can copy and paste a single problem from one location to another 
within the same document or a different document. You can also delete 
a problem from the document.

Copying and pasting a problem
To copy and paste a problem:
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1. Open the Page Sorter.

Press /  £ or ~ 3 3.

2. Select the problem. If there are multiple problems, you can press 

b 2 to Collapse the Page Sorter to list the problems by number 
and title only.

3. Press / C.

4. Go to the location where you want the problem to appear.

5. Press / V.

A duplicate problem is placed in the new location.

Deleting a problem
To delete a problem from the document:

1. Select the problem from the Page Sorter.

2. Press / X.

The problem is deleted from the document.

Renaming a problem
To rename a problem:

1. With the document active, open the Page Sorter.

Press /  £.

2. Select the problem name.

3. Press / b.

4. Select 7 Rename and type the name.
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5. Press / S to save the change.

Adding a page to a problem
Each problem can contain up to 50 pages. To add a new page to a 
problem:

Press / ~ or / I to add a blank page and select an 
application

—OR— 

Press c to display the Home screen, then point to the application 
you’d like to add to the new page and click or tap.

A new page is added to the current problem. 

 

Note: The tab at the top left of the screen indicates that this is the 
second page of the second problem. 

Moving through pages in a document
Tabs display up to three multiple pages. When a document contains more 
than three pages, arrows appear on the left and right of the tabs. 

Use the following keys to navigate through your documents.

• /  3  displays the previous page.

• /  4  displays the next page.

• /  5  displays the Page Sorter.

• /  ¤ displays the previous view.

• Use the Touchpad to click on the arrows that appear on either side of 
the tabs to show additional pages in a document containing more 
than three pages.
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Managing documents
My Documents is a file manager where you store and organize your 
documents. The example below illustrates the My Documents screen with 
its main parts labeled. Following the screen, you can find descriptions of 
each labeled part.

À Expanded folder

Á Current, unsaved document

Â Collapsed folder

Ã System status indicators

Ä File size

Browsing files in My Documents
To open My Documents:

Press c 2.

Note: If you are working in a page, press / 5 / 5.

À

Á

Â

Ã

Ä



44 Working with documents on the CX handheld

The My Documents screen opens, displaying all folders and files on 
the handheld.

• To sort columns by name or size, click that column head. Click 
again to change the sort from ascending to descending.

• To scroll through My Documents, click or grab the scroll bar.

• To expand a single folder, point to the folder and click on the 
folder icon or press / ¢. To collapse, click again or press / ¡.

• To expand all folders, press b 7. To collapse, press b 8.

Renaming folders or documents
To rename a folder or document:

1. Press the 5 and 6 keys to highlight the document or folder you want 
to rename. 

2. Press b 2. 

 

The document or folder name is highlighted. 

3. Type a new name and press · to complete the change.

Note: Press d to cancel.

Creating folders 
You can create folders two different ways:

• You can create a folder when you save a new document: The Save 
and Save As... menu commands allow you to enter a new folder 
name for the document. 

• You can create a folder directly from the My Documents screen. Press 
b 1. Type a name for new folder, and press x or · to add it.
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File and folder naming conventions
Folder names must be unique. File and folder names can be very long, 
and can include almost all characters, including spaces and punctuation.

Note: If you are planning to transfer these documents to your computer 
for use in the TI-Nspire™ software, it is best to use names that are 
accepted on your computer. Avoid punctuation, \, /, or symbols.

Deleting documents and folders
1. Press 5 and 6 to highlight the document or folder you want to 

delete.

2. Press / b 6 or press .. 

A dialog box displays, confirming that you want to delete the file or 
folder.

3. Press x or · to select Yes.

The document is deleted.

Duplicating documents and folders

Use Copy / C and Paste / V to duplicate documents and folders.
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To copy a document to another folder, select the desired folder, then 
paste.

Recovering deleted documents
Most operations performed in My Documents can be undone. Press 
/ Z (Undo) to cancel the last operation until the deleted document is 
restored.

Closing a document

1. To close a document, press ~ 1 3 or / W.

If you have changed the document, you will be asked whether you 
want to save those changes.

2. Click Yes to save the document or click No to abandon the changes.

Understanding the TI-Nspire™ tools
This section provides an overview of the tools used when working with 
TI-Nspire™ documents on a handheld, including variables, catalog, 
symbols, and math templates. 

Creating TI-Nspire™ variables 
Variables can be any portion or attribute of an object or function created 
within an application. Examples of attributes that can become variables 
are the area of a rectangle, the radius of a circle, the value contained in a 
spreadsheet cell or the contents of a column, or a function expression. 
When you create a variable, it is stored in memory within the problem. 
You will find more information about variables in the chapter titled 
Using Variables.

Using the catalog
Use the catalog to access a list of TI-Nspire™ commands and functions, 
units, symbols and expression templates. Commands and functions are 
listed alphabetically. Commands or functions not beginning with a letter 
are found at the end of the list (&, /, +, -, and so on). To open the catalog:

1. From an open document, press k to open the catalog.
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2. Press the number key corresponding to the appropriate tab. 

For example, press 2 to show a list of math functions.

3. Press 6 until the item you want to insert is highlighted.

A syntax example for the selected item displays at the bottom of the 
screen.

Note: To see additional syntax examples of the selected item, press 
e, and then press · to maximize or minimize the Help. To move 

back to the selected item, press g e.

4. Press · to insert the item.

About the catalog window
The catalog window uses these tabs to categorize commands, special 
characters, and templates in documents:

Contains all commands and functions, in alphabetical 
order

Contains all math functions

Provides a symbol palette for adding special characters

Contains math templates for creating two dimensional
objects, including product, sum, square root, and integral
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CAS:

Using wizards
Some catalog functions have a wizard to help you enter function 
arguments. To use a wizard, press e until the Wizards On box is 

highlighted. Press x or · to select the check box.

Shows public library (LibPub) objects

Contains all commands and functions, in alphabetical 
order

Contains all math functions

Provides the values for standard measurement units

Provides a symbol palette for adding special characters

s
Contains math templates for creating two dimensional
objects, including product, sum, square root, and integral

Shows public library (LibPub) objects
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Using special characters or math templates

Entering special characters
The symbol palette contains a subset of the objects found in the catalog. 
To open the symbol palette:

1. In an open documents, press / k.

2. Press 3, 4, 5oor 6 to select a symbol.

3. Press · to insert the symbol.

Entering math expressions
Use math expression templates to create two-dimensional objects such as 
summation, integral, derivative, and square root. To open the math 
expressions palette:

1. In an open document, press t.

2. Press 3, 4, 5oor 6 to select an expression.

3. Press x or · to insert the expression.
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Entering international language characters

Use the ; key to enter specially accented or punctuated characters in 
applications such as Notes that allow text input. 

1. Open an application such as Notes that allows text input. 

2. Type the desired text.

3. Position the cursor after the letter that you want to accent. For 
example, “e" while in the French locale. 

Press ; on the keypad. Notice that the “e" changes to “é.“ Keep 

pressing ; until you find the accented version of e that you want. Press 

_ or the next letter of your text to accept the character and continue 

typing. 
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Working in a TI-Nspire™ Navigator™ 
Teacher Software classroom

If you are in a classroom where TI-Nspire™ Navigator™ Teacher Software 
is used, you will need to log in to class and answer questions sent to your 
handheld by the teacher. The teacher can also pause and restart your 
handheld. When paused, you will receive a message on your handheld. 
You cannot use your handheld until the teacher releases the handheld 
from pause mode.

Logging in to class
Complete the following steps to connect to a classroom session.

1. From the Home screen, press 5 5 to open the Login to Class dialog 

box. From an open document, press ~ 8.

2. Type your user name and password and click Login.

TI-Nspire™ handheld login status icons
The icons on the TI-Nspire™ CX, TI-Nspire™ CX CAS, TI-Nspire™, and 
TI-Nspire™ CAS handheld screens indicate the communication status 
between the handheld and the access point, wireless adapter, wireless 
cradle, or TI-Navigator™ network. The icons indicate status as follows.

Icon Status Meaning

Blinking The handheld is searching for an access 
point.
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Pausing a class session
There are times when a teacher may want to pause a class. Pausing a class 
suspends all activity on your handheld. When the teacher resumes class, 
the message clears and you are able to use the handheld.

Responding to Quick Poll questions
When your teacher sends a Quick Poll question, the question opens as a 
new document on your handheld, on top of any document you may 
currently have open. When Quick Poll is active, the option appears on the 
Home screen below the Scratchpad options.

Answering a Quick Poll question
If the teacher gives permission, the Quick Poll tool allows you to 
temporarily exit the question to perform calculations or access other 
documents to determine the answer to the question. For example, you 
can access the Scratchpad to perform a function, or you can access the 
Lists and Spreadsheet application and copy data from there to a List 
question type. To calculate and submit your answer, complete the 
following steps:

1. Press c to access the Home screen. 

Solid The handheld has found an access point.

Solid The handheld is not communicating 
with the adapter or cradle. Unattach the 
handheld from the adapter or cradle, 
wait for the icon to disappear, and then 
reattach the handheld to the adapter or 
cradle.

Blinking The handheld is connected to the 
network and is ready to login.

Solid The handheld is logged in to the 
network and is fully charged.

Icon Status Meaning
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2. Choose an application.

Note: To return to the Quick Poll without accessing any documents, 
choose Quick Poll.

3. When you are finished, click the Quick Poll icon on the top of the 
handheld screen to return to the Quick Poll tool.

4. To submit your answer to the teacher, press ~ and choose Submit 
Answer.

Note: Choose Clear Answer to clear your answer and try again.

When you respond to a poll, your response is immediately sent to the 
teacher’s computer and teachers can keep track of student responses in 
real time. When you submit your answer, their computer is updated with 
the answer you submitted. Your teacher may have set the poll to allow 
you to submit your answer more than once. If so, you can continue to 
respond to the poll and submit it, until your teacher stops the poll.

Responding to different question types

For Multiple Choice questions, use e to navigate to your response. 

Press · to mark your response.

For Open Response questions, press e to move the cursor to the 
answer box, and type your response.

For Equation questions, press e to move the cursor to the answer 
box, and type your response. If a graph is included with the question, 
when you press ·, the function you entered shows up on the 
graph. Your cursor will still be in the answer box. You cannot 
manipulate the graph itself. The graph updates when you type an 
answer and press ·.

For Coordinate Points: (x,y) questions, press e to move the cursor 

to the x-field answer box. Type your answer, and press e to move 
to the y-field box. Type your answer. 

If a graph is included with the question, when you press ·, the 
function you entered shows up on the graph.

You can use / b to access the Window and Zoom functions 
while you are working on the graph.

For Coordinate Points: Drop Points questions, press e to move the 

cursor to a point on the graph. Press · to drop a point at that 
location.

If you need to delete a point, press / Z to undo the action.
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For Lists questions, press e to move the cursor to the first cell of the 

list. Type your answer, and press e to move to the next cell. Type 
your answer.

The behavior in a Lists question closely matches the behavior of the 
Lists and Spreadsheet application, with the following exceptions. In a 
Lists question, you cannot:

• Add, insert, or delete columns

• Change the header row

• Enter formulas

• Switch to Table

• Create plots

Clearing your answers
After you answer a Quick Poll, you may decide you want to change your 
answer before you submit it to your teacher. 

1. Press b to access the Check Answer menu.

2. Click Menu > Clear Answers > Current Question or Document.

• Current Question clears your answers for the active question.

• Document clears your answers for all questions contained in the 
active document.

—OR—

If you answered the question and are ready to submit it, you still have 
time to clear your answer before you submit it to your teacher. 

Press ~ and choose Clear Answer to clear your answer and try 
again.
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Configuring the TI-Nspire™ CX handheld

This chapter provides information needed to:

• Maintain batteries used in the handheld 

• Change the default settings

• Attach a wireless module when the handheld is used in the classroom

Checking battery status
To check the status of the TI-Nspire™ Rechargeable Battery in a 
handheld:

1. Press c to access the Home screen.

2. Press 5 4 to open the Handheld Status window.

3. Click OK or press · to close the window.

Note: From an open document, press ~ 7 4.

Recharging the handheld
To recharge the TI-Nspire™ Rechargeable Battery in a handheld, connect 
it to either of the following power sources:

• A standard USB cable connected to a computer

• A TI USB wall charger (sold separately)

• A TI-Nspire™ CX Docking Station if in a classroom setting

The amount of time required to fully charge the battery may vary, but 
charging normally takes about six hours. It is not necessary to remove the 
TI-Nspire™ Rechargeable Battery from the handheld to recharge it. The 
handheld operates normally while it is attached to a charging source.

Battery status 
is shown here.
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Recharging your battery from a computer
To recharge a handheld from a computer, a TI-Nspire™ USB driver must 
be installed. USB drivers are standard with any TI-Nspire™ software, 
which includes:

• TI-Nspire™ Teacher Software

• TI-Nspire™ CAS Teacher Software

• TI-Nspire™ Student Software

• TI-Nspire™ CAS Student Software

• TI-Nspire™ Navigator™ Teacher Software

To download software that includes a driver, go to 
education.ti.com/software.

Understanding the priority of power sources
When the TI-Nspire™ Rechargeable Battery is fully charged, the 
handheld draws power in the following order:

• First, from a connected external power source, such as:

– A computer connected through a standard USB cable

– An approved wall charger (sold separately)

• Second, from the TI-Nspire™ Rechargeable Battery 

Disposing of used batteries safely and properly
Do not mutilate, puncture, or dispose of batteries in fire. The batteries 
can burst or explode, releasing hazardous chemicals. Discard used 
batteries according to local regulations.

Changing handheld settings
Use the options on the Settings menu to change or view the following 
settings:

• Change language

• Settings (General and Graphs & Geometry)

– Define or restore settings for open documents and the Scratchpad

– Define or restore default settings for the handheld

• Handheld Setup

• Status

• Login
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Note: Not all options are accessible at all times. Options that are 
unavailable are grayed out.

Opening the Settings menu

From the Home screen, press 5 or use the touchpad to select 
Settings.

The Settings menu opens.

Changing the preferred language
Complete the following steps to change the preferred language:

1. From the Home screen, press 5 or select Settings to open the menu.

2. From the menu, select Change Language or press 1 to open the 
Change Language dialog box.

3. Press ¢ to open the drop-down menu.

4. Press ¤ to highlight a language, then press x or · to select it.

5. Press e to highlight the OK button, then press x or · to save 
the language selection.
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Customizing the handheld setup
Handheld setup options enable you to customize options to suit your 
needs. 

• Font size (small, medium, or large)

• Power standby. (1, 3, 5, 10, or 30 minutes)

– Use this option to extend battery life

– By default, the handheld automatically powers down after three 
minutes of inactivity.

• Hibernate (1, 2, 3, 4, 5 days, or never)

– Use this option to extend battery life.

– By default, the handheld hibernates after four days.

– When hibernating, the handheld saves current work in memory.

– When you turn the handheld on again, the system reboots and 
opens saved work.

• Pointer speed (slow, normal, or fast)

• Auto dim (30, 60, or 90 seconds and two or five minutes)

• Enable tapping to click

Changing Handheld Setup options

1. From the Home screen, press 5 3. The Handheld Setup dialog box 
opens.

 

2. Press e until the desired category is highlighted.

3. Press ¢ to view the list of possible settings.

4. Press 6 to highlight the desired setting.
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5. Press x or · to select the new setting.

6. When you have changed all the settings to suit your needs, press 
e until OK is highlighted, then press x or · to apply your 
changes. 

Note: Click Restore to return the handheld to the factory settings.

Customizing General settings
General settings control how the handheld displays and interprets 
information in TI-Nspire™ documents and in Scratchpad. All numbers, 
including elements of matrices and lists, are displayed according to the 
general settings. You can change the default settings at anytime and you 
can also specify settings for a particular document. 

General settings and their possible values are listed in the following 
table.

Field Values

Display Digits Float
Float1 - Float12
Fix0 - Fix12

Angle Radian
Degree
Gradian

Exponential Format Normal
Scientific
Engineering

Real or Complex Real 
Rectangular
Polar
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Changing the default General Settings
Complete the following steps to select general settings that are applied 
to all TI-Nspire™ documents and to Scratchpad. 

1. Save and close any open documents.

2. From the Home screen, press 5 2 1 to open the General Settings 
dialog box.

Calculation Mode Auto
CAS: Exact
Approximate

Note: Auto mode displays an 
answer that is not a whole number 
as a fraction except when a decimal 
is used in the problem. Exact mode 
(CAS) displays an answer that is not 
a whole number as a fraction or in 
symbolic form, except when a 
decimal is used in the problem.

Vector Format Rectangular
Cylindrical
Spherical

Base Decimal
Hex
Binary

Unit System (CAS) SI
Eng/US

Field Values
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3. Press e to move through the list of settings. Press £ to move 
backward through the list.

A bold line around a box indicates it is active.

4. Press ¢ to open the drop-down menu to view the values for each 
setting.

5. Press the £ and ¤ keys to highlight the desired option, then press 

x or · to select the value.

6. Click Make Default to save all the settings as default settings that will 
be applied to all future TI-Nspire™ documents, PublishView™ 
documents, and to Scratchpad.

• Select the question mark to open Help. 

• Select Restore to restore the original factory settings.

Changing General Settings in a TI-Nspire™ document
Complete the following steps to change general settings for an open 
TI-Nspire™ document. You can apply the settings to the current 
document only or choose to make the settings the default settings for 
the open document and all future documents.

1. To access General Settings from an open document, press 
c 5 2 1.

2. Press e to move through the list of settings. Press £ to move 
backward through the list. 

A bold line around a box indicates it is active.

3. When you reach the desired setting, press ¢ to open the drop-down 
menu to view values for each setting.
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4. Press the 5 and 6 keys to highlight the desired option, then press 

x or · to select the value.

5. Click OK or press x or · to apply the new settings to the open 
document and return to the Home screen. When you click OK, the 
settings are only applied to the open document.

To apply the new settings to this document and documents created in 
the future, select Make Default and press x or ·.

• Click OK to apply the settings to any open documents and save the 
settings as defaults for new documents and for Scratchpad.

Restoring General Settings
Complete the following steps to restore the original factory settings to 
open or new documents and to the Scratchpad.

1. From the Home screen, press 5 2 1 to open the General Settings 
dialog box.

2. Use the Touchpad or press e to select Restore, then press ·. 
The Restore Defaults dialog box opens.
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3. Select OK to restore settings to the factory default settings.

4. Press OK or d to return to the Home screen.

Customizing Graphs & Geometry settings
The changes made to Graphs & Geometry settings apply to graphs and 
geometry in open documents and in subsequent new documents. When 
you customize application settings, your selections become the default 
settings for all of your work in the Graphs & Geometry application. 

The following table lists the Graphs & Geometry application settings with 
selectable values and descriptions of operation for enabled checkboxes. 

Field Values

Display Digits Auto

Float

Float1 - Float12

Fix0 - Fix12

Graphing Angle Auto

Radian

Degree

Gradian

Geometry Angle Auto

Radian

Degree

Gradian

Checkbox Operation when checked

Automatically hide plot labels Plot labels display only when a plot 
is hovered, selected, or grabbed.

Show axis end values Displays a numeric label at the least 
and greatest values visible on an 
axis.

Show tool tips for function 
manipulation

Shows helpful information as you 
manipulate function graphs.

Automatically find a point of 
interest

Shows zeros, minima, and maxima 
for graphed functions and objects 
while tracing function graphs.
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Changing default Graphs & Geometry Settings
Complete the following steps to change the Graphs & Geometry Settings 
and make these settings the default for all new documents and 
Scratchpad.

1. Save and close any open documents and close Scratchpad.

2. From the Home screen, press 5 2 2. 

The Graphs & Geometry Settings dialog opens.

3. To change the Display Digits, Graphing Angle, and Geometry Angle, 

press e to select an option, then click ¢ to open the drop-down 

menu. Press ¤ to view the values, then press x or · to select a 
value.

4. In the lower half of the dialog, click a checkbox to enable or disable 
an option.

5. Highlight and click Make Default. The Apply and Save as Default 
dialog box opens.

6. Click OK to save your settings as default for new documents and 
Scratchpad.
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Changing Graphs & Geometry settings in TI-Nspire™ 
documents
Complete the following steps to change Graphs & Geometry settings for 
an open TI-Nspire™ document. You can apply the settings to the current 
document only or choose to make the settings the default settings for 
the open document and all future documents.

1. From an open document, press c 5 2 2. The Graphs & 
Geometry Settings dialog box opens.

2. Click ¢ to open the drop-down menu for Display Digits, Graphing 

Angle, or Geometry Angle settings, then press ¤ to view the values. 

Press x or · to select a value.

3. In the lower half of the dialog, click a checkbox to enable or disable 
an option.

4. Click OK or press x or · to apply the new settings to the open 
document and return to the Home screen. When you click OK, the 
settings are only applied to the open document.

To apply the new settings to the current document and all future 
documents, click Make Default and press x or ·.
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Click OK to apply the settings to any open documents and save the 
settings as default for new documents and Scratchpad.

Restoring Graphs & Geometry Settings
Complete the following steps to restore the original factory settings to 
open or new documents and to the Scratchpad.

1. From the Home screen, press 5 2 2 to open the Graphs & 
Geometry Settings dialog box.

2. Use the Touchpad or press e to highlight Restore.

3. Press ·. The Restore Defaults dialog box opens.

4. Click OK to restore Graphs and Geometry settings to the factory 
default settings.

5. Press d to return to the Home screen.

Viewing handheld status
The Handheld Status screen provides the following information about 
the current state of the handheld:

• Battery status for the rechargeable batteries

• Software version

• Available space

• Network (if any)

• Your student login name and whether you are logged in 

• About
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Opening the Handheld Status screen

1. From the Home screen, press 5 4. The Handheld Status screen 
opens.

2. Click OK to close the Handheld Status screen.

Viewing handheld details on the About screen
The About screen provides additional information about the handheld 
type, the operating system (OS) version, and the product ID.

1. From the Home screen, press 5 4. The Handheld Status screen 
opens.

2. Click About to view details about the handheld.

3. Click OK to close the About dialog box.

4. Click OK to return to the Home screen.

Replacing TI-Nspire™ Rechargeable Battery
When you replace the battery, complete the following steps to insert the 
TI-Nspire™ Rechargeable Battery into a handheld.
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1. Use a small screwdriver to release the panel from the back of the 
handheld.

2. Remove the panel.

3. Insert the white connector into the jack located at the top of the 
battery compartment, as shown.

4. Thread the wire into the case to secure it. Insert the rechargeable 
battery into its compartment.

5. Replace the back panel and fasten the screws with a screwdriver.

Using wireless communication hardware
Teachers using TI-Nspire™ Navigator™ Teacher software in the classroom 
can use wireless network adapters along with the TI-Nspire™ access 
point to establish wireless communication between TI-Nspire™ CX 
handhelds and their computer. The wireless cradle can be used to 
establish a wireless connection between the teacher’s computer and any 
TI-Nspire™ handheld. This section provides information about how to 
attach wireless communication hardware to a TI-Nspire™ handheld.

Attaching a wireless adapter to a handheld
The TI-Nspire™ CX wireless network adapters work with the TI-Nspire™ 
CAS and TI-Nspire™ CX CAS handhelds. The battery in the TI-Nspire™ CX 
handheld powers the wireless adapter. To connect the handheld to the 
wireless adapter:

1. Position the wireless adapter on top of the handheld so the connector 
on the adapter lines up with the connector on top of the handheld. 

2. Slide the adapter into position, making sure the guides on the sides 
of the adapter slide into the grooves on the sides of the handheld.

Wireless 
network 
adapter 
(school-
owned)

Connector

Guides for 
aligning 
with 
handheld
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3. Firmly press the adapter into place so that the adapter sits on top of 
the handheld as shown in the following illustration.

Note: The TI-Nspire™ CX handheld can be charged with the wireless 
adapter attached.

Groove to align 
wireless adapter

Sideview of handheld
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Attaching a wireless cradle to a handheld
The wireless cradles can also be used with all TI-Nspire™ handhelds to 
wirelessly connect to the teacher’s computer. To connect a handheld to a 
wireless cradle:

1. Slide the lock on the back of the cradle to the OFF position.

2. To attach the handheld, face the screen upward and slide the 
handheld onto the top of the TI-Nspire™ Navigator™ wireless cradle. 
Be sure that both sides of the handheld are inserted into both of the 
side guides.

3. Press firmly to make a good connection. When properly connected, 
the TI-Nspire™ CX handheld appears to be sitting on top of the 
cradle.

Lock in OFF position.
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4. Lock the handheld in place by sliding the lock on the back of the 
cradle to the ON position.

Lock in ON position.
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Connecting handhelds and transferring 
files

This chapter describes how to connect one TI-Nspire™ handheld to 
another, how to connect handhelds to a computer, and how to transfer 
files between them. 

The TI-Nspire™ handhelds have a USB port that enables connectivity with 
another TI-Nspire™ handheld or with a computer.

Note: When using the TI-Nspire™ TI-84 Plus keypad, you can connect 
with another TI-Nspire™ handheld using the TI-Nspire™ TI-84 Plus 
keypad or a TI-84 Plus using the USB port or the I/O port.

Connecting handhelds

Using USB cables
You can use USB cables to connect two TI-Nspire™ handhelds, to connect 
a TI-Nspire™ handheld to a computer, or to connect one TI-Nspire™ 
handheld using TI-Nspire™ TI-84 Plus keypad to another.

Connecting two TI-Nspire™ handhelds with the mini-USB 
cable 
You can connect two handhelds as long as both handhelds are using the 
same keypad. You cannot connect a handheld using the TI-Nspire™ TI-84 
Plus keypad to a handheld using the native TI-Nspire™ keypad.

TI-Nspire™ USB connection 
cable to connect handheld to 
a computer.

TI-Nspire™ handheld mini-USB 
cable to connect two 
TI-Nspire™ handhelds.
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To connect the handhelds:

1. Firmly insert either end of the mini-USB cable into the USB port.

2. Insert the other end of the cable into the receiving handhelds’s USB 
port.

Connecting the TI-Nspire™ handheld to a computer  

Transferring files to and from handhelds
You can send documents, Operating System (OS) files, and folders to 
another TI-Nspire™ handheld.

The TI-Nspire™ handheld USB 
port is located in the center on 
the top of the TI-Nspire™ 
handheld.

The USB port is located on the top 
of the TI-Nspire™ CX handheld on 
the right side when holding the 
handheld with the screen facing 
you.

1. Firmly insert the mini-USB end of the cable into the port at the top 
of your handheld. 

2. Firmly insert the USB end of the cable into the USB port of the 
computer.

Port for 
connecting a 
wireless 
adapter

USB port on the 
CX handheld
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Rules for transferring files and folders
• You can transfer documents and Operating System (OS) files.

• Operating systems are not interchangeable between different 
handheld types. For example, you cannot transfer a CAS operating 
system to a non-CAS handheld.

• If a document with the same name as the one you are sending 
already exists on the receiving TI-Nspire™ handheld, the document 
will be renamed. The system appends a number to the name to make 
it unique. For example, if Mydata existed on the receiving TI-Nspire™ 
handheld, it would be renamed Mydata(2).

Both the sending and receiving handhelds will display a message that 
shows the new name. 

• There is a 255-character maximum length for a file name, including 
the entire path. If a transmitted file has the same name as an existing 
file on the receiving handheld and the file names contain 255 
characters, then the name of the transmitted file will be truncated to 
enable the software to follow the renaming scheme described in the 
previous bullet.

• All variables associated with the document being transmitted are 
transferred with the document.

• Transmissions will time out after 30 seconds.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only 
files. If you receive an error in sending to an older TI-Nspire™ handheld, 
see Common error and notification messages.

Sending a document or folder to another handheld
1. Ensure the two handhelds are connected.

2. Open the My Documents file browser and navigate to the file or 
folder you want to transfer.

3. Press the 5 and 6 keys on the Touchpad to highlight the document or 
folder you want to send.

4. Press ~ 1 6 to select Send from the Documents menu.

TI-Nspire™ handheld: Press ~16.

5. The file transfer begins. A progress bar displays to allow you to follow 
the transfer. There is also a cancel button on the Sending... dialog to 
enable you to cancel the transmission while it in progress.
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At the end of a successful transmission, the message 
“<Folder / File name> transferred as <Folder / File name>.” displays. If 
the file had to be renamed on the receiving handheld, the message 
will display the new file name.

Receiving a document or folder
No action is required by the user of the receiving TI-Nspire™ handheld. 
Handhelds are automatically powered on when the cable is attached. 

At the end of a successful transmission, the message “<Folder / File 
name> received.” displays. If the file had to be renamed, the message 
will display the new file name.

Caution: Some older TI-Nspire™ handhelds cannot receive folders; only 
files. If you receive an error in sending to an older TI-Nspire™ handheld, 
see Common error and notification messages.

Canceling a transfer
1. To cancel a transmission in progress, press Cancel on the dialog of the 

sending handheld. The user of either handheld can also press d. 

(TI-Nspire™ handheld: press d).

2. Press d or · to cancel the transmission error message. 

TI-Nspire™ handheld: press d or ·.

Transferring files between computers and 
handhelds
In the Documents Workspace, teachers and students can use the “drag 
and drop” method to quickly transfer files and folders from a computer 
to a handheld or transfer files from a handheld to a computer.

1. Connect the handheld to the computer using a standard A to mini-B 
USB cable.

2. In the TI-Nspire™ software, open the Documents Workspace.

3. In the Documents Toolbox, click  to open the Content Explorer.
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4. Navigate to the folder that contains the file you want to transfer.

• To transfer a file from a handheld to the computer, select the file, 
then “drag and drop” the file to a folder in the Computer pane.

• To transfer a file from the computer to a handheld, select the file, 
then “drag and drop” the file to a connected handheld. 

Note: Those using the TI-Nspire™ Teacher Software or the TI-Nspire™ 
Navigator™ Teacher Software can also use options in the Content 
Workspace to transfer files from a handheld to a computer.

Using the Save to Handheld option
In the Documents Workspace, you can also use the Save to Handheld 
option on the File menu to transfer a file to a connected handheld when 
you want to save a file to a specific folder on the handheld.

1. Ensure the handheld is connected to the computer.

2. In the Computer pane, navigate to the folder where the file is 
located.

3. Select the file.

4. Select File > Save to Handheld. The Save to Handheld window opens.

Computer pane

Connected Handhelds
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5. Double-click the handheld name, then navigate to the folder where 
you want to save the file.

6. Click Save. The file is saved to the selected folder and the Save to 
Handheld window closes.

Handling errors resulting from sending folders
If you receive an error after attempting to send, it may mean the 
receiving handheld has an operating system that does not support the 
transfer. To resolve this, update the receiving handheld’s OS and try the 
send again.
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Common error and notification messages

Shown on Message and Description

Sending handheld

If you get an error when sending a folder to an 
older TI-Nspire™ handheld, try updating the OS on 
the receiving handheld. If the error persists, you 
may have to send the files individually.

Sending handheld

This message is displayed if a cable is not attached 
to the sending handheld’s link port. Remove and 
then reinsert the cable and try the document 
transmission again.

Select OK to cancel the transmission message. 

Note: The sending handheld may not always 
display this message. Instead, it may remain BUSY 
until you cancel the transmission.

“This folder structure is not
supported on the receiving 
handheld. The receiving
handheld’s OS may need to
be updated, which you can
do by selecting Send OS 
from the My Documents 
menu.”

OK

“Transfer failed. Check cable
and try again.“

OK
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Sending handheld

This message indicates that the receiving handheld 
does not have enough memory to accept the file 
being transmitted. 

The user of the receiving handheld must free space 
to obtain the new file. To do this:

• Delete unneeded files.

• Store files on a computer for later retrieval, 
then delete them from the TI-Nspire™ 
handheld.

Sending handheld

This message is displayed at the end of a successful 
transfer when the file had to be renamed because 
a file already exists on the receiving handheld with 
the original name. The transmitted file is renamed 
by appending a number to the end of the name. 
Rename numbering always begins with (2) and can 
increment by one, as needed.

Shown on Message and Description

“Receiver does not have enough 
storage space for file transfer.“

OK

“<folder>/<filename> 
transferred as 

<folder>/<filename(#).“
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Sending handheld

This message indicates that a new folder was 
created on the receiving handheld to contain the 
transmitted document.

Receiving 
handheld

This message indicates that the receiving handheld 
has a document with the same name as the 
document being sent. 

Receiving 
handheld

This message indicates that a new folder has been 
created to contain the transmitted document.

Shown on Message and Description

“<folder>/<filename>

 <folder>/<new filename>.“
transferred as

“<folder>/<filename(x)>
received.“

“<new folder>/<new filename>
received.“



82 Connecting handhelds and transferring files

Receiving 
handheld

This message indicates that the cable is not 
correctly attached to the receiving handheld’s link 
port. Remove the cable then reattach it and try the 
transmission again.

Select OK to cancel the transmission message. 

Shown on Message and Description

“Transfer failed. Check cable
and try again.“

OK
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Memory and file management

The TI-Nspire™ CX handheld comes equipped with 192 MB of memory. 
Of the total memory, 128 MB is dedicated to Flash storage and 64 MB is 
RAM. When the operating system is loaded, and as documents are 
created and stored on the handheld, memory is used and you may find 
that you need to free or restore memory after several months of use.If 
there is insufficient memory on the handheld, use one of the following 
options to restore space on the handheld:

• Delete documents and folders you no longer use

• Back up files and folders to another handheld or computer

• Reset the memory, which deletes ALL files and folders on the 
handheld.

Checking available memory
Complete the following steps to view the amount of memory (in bytes) 
used by all documents and variables on your handheld.

1. From the Home screen, select Status from the Settings menu.

Press c 5 4.

The Handheld Status window opens.

2. View the Available Space field to determine how much memory is 
available on the handheld.

3. Click OK to return to the Home screen.
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Freeing memory
To free or recover memory, delete documents and/or folders from the 
handheld. To keep the documents and folders for later use, transfer them 
to another handheld or to a computer using the TI-Nspire™ software.

Deleting files from the handheld

1. Press c 2 to open the My Documents file browser.

2. Press £ or ¤ to select the folder or document you want to delete.

3. Press . or press / b 6.

A dialog box opens, asking you to confirm the deletion.

4. Press · to confirm or d to cancel.

The folder/document is permanently removed from the handheld.

Backing up files to another handheld
1. Connect the two handhelds using the USB-to-USB connectivity cable.

2. Press c 2 to open My Documents on the sending handheld. 

3. Press the 5 and 6 keys to highlight the document you want to send.

4. Press b, then select Send or press / b 2.

5. When the file transfer is complete, a message is displayed on the 
receiving unit.

Transferring files to a computer
Use the TI-Nspire™ software to transfer files and folders from a handheld 
to a computer.

1. Connect your handheld to the computer using a standard A to mini-B 
USB cable.
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2. In the TI-Nspire™ software, open the Documents Workspace.

3. In the Documents Toolbox, click  to open the Content Explorer. 

4. In the Computer pane, navigate to the folder where you want to save 
the files.

5. In the Connected Handhelds pane, double-click the handheld name 
to view the folders and files on the handheld.

Computer 
pane

Connected 
Handhelds 
pane
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6. Select the file or folder you want to save to the computer.

• Click the file to select one file or folder at a time.

• To select all files on the handheld, select the first file in the list, 
hold down the Shift key, then click the last file or folder in the list.

• To select random files, click the first file, then hold the Ctrl key 
while selecting additional files.

Note: If you select multiple files, it is saved as lesson bundle (.tilb file).

7. Drag the files to the folder in the Computer pane or select File > Save 
as. The files are copied to the folder on the computer.

8. Verify that the files you need are available on your computer, then 
delete the files from the handheld.

Note: Those using the TI-Nspire™ Teacher Software or the TI-Nspire™ 
Navigator™ Teacher Software can also use options in the Content 
Workspace to copy files from a handheld to a computer.

Resetting the memory
Complete these steps only if you want to delete ALL files and folders on 
your handheld.

Caution: Before you reset all memory, consider restoring sufficient 
available memory by deleting only selected data. If you reset all memory, 
the pre-installed applications on your handheld will remain, but any 
applications that have been downloaded in TI-84 mode will be deleted.

1. After making certain you want to clear all files, press c 2 to 
open the My Documents file browser.

2. Press b to open the context menu.

3. Select Delete All or press C. The Data Loss dialog box opens.

4. Click OK to confirm that you want to clear the handheld memory.
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Updating the handheld operating system

To take advantage of the latest handheld features and updates, 
download the latest operating system files from the Education 
Technology web site (education.ti.com). You can update the operating 
system (OS) on TI-Nspire™ handhelds using a computer and the 
following software:

• TI-Nspire™ Teacher Software

• TI-Nspire™ Student Software

• TI-Nspire™ CAS Teacher Software

• TI-Nspire™ CAS Student Software

• TI-Nspire™ Navigator™ Software

In the classroom, you can use the TI-Nspire™ Docking Stations to 
upgrade the OS on multiple handhelds at the same time. 

You can also transfer the OS from one TI-Nspire™ handheld to another 
or from one TI-Nspire™ CX handheld to another. However, handheld 
operating systems are not interchangeable. You cannot transfer a CAS 
operating system to a non-CAS handheld and you cannot transfer a 
TI-Nspire™ handheld operating system to a TI-Nspire™ CX handheld.

What you need to know
• If there is not enough room on the receiving handheld for the 

upgrade, a message is displayed. See Memory and file management 
for more information about restoring memory.

• OS upgrade operations do not delete user documents. The only time 
documents are affected by an OS installation is if the receiving 
handheld has a corrupted OS. In this situation, documents may be 
affected by OS restoration. It is a good practice to back up important 
documents and folders before installing an updated operating 
system.

Warning: Upgrading the operating system will delete all TI-84 
applications and files. Before installing an OS upgrade, you should use 
TI Connect to back up all TI-84 applications and files to a computer. You 
can copy them back to the handheld when the OS upgrade is complete.

Before you begin
Before beginning an OS download, ensure that batteries are at least 25 
percent charged. 
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• To check the status of the rechargeable battery in TI-Nspire™ CX 
handhelds, press c 5 4 to open the Handheld Status dialog.

• To check the status of both the rechargeable battery and the AAA 
batteries in TI-Nspire™ handhelds, press c54 to open the 
Handheld Status dialog.

When in OS download mode, the Automatic Power Down™ (APD™) 
feature does not function. If you leave your handheld in download mode 
for an extended time before you begin the downloading process, your 
batteries may become depleted. You will then need to replace or 
recharge the batteries before downloading the OS.

Finding operating system upgrades
For up-to-date information about available OS upgrades, check the Texas 
Instruments web site at http://education.ti.com. 

You can download an OS upgrade from the Texas Instruments web site to 
a computer, and use a USB cable to install the OS on your TI-Nspire™ 
handheld. You will need an Internet connection and the appropriate USB 
cable to download the updates.

Checking for handheld OS updates
When using TI-Nspire™ software, you can quickly determine if your 
handheld OS is up to date when the handheld is connected to a 
computer. 

1. Open your TI-Nspire™ software and ensure your handheld is 
connected to your computer.

2. In the Documents Workspace, click  to open Content Explorer. 

3. In the Connected Handhelds pane, select a connected handheld.
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4. Select Help > Check for Handheld OS Update.

• If the operating system is current, the Check for Handheld OS 
Update dialog is displayed indicating that the operating system on 
the handheld is up to date.

• If the operating system is not current, the dialog box contains a 
message indicating that a new version of the operating system is 
available.

5. To turn off automatic notifications, deselect “Automatically check for 
updates.” By default, this option is turned on.

6. Click OK to close the dialog box.

Upgrading the Operating System
In the TI-Nspire™ software, you can select to upgrade the operating 
system on a connected handheld from the following workspaces and 
menus:

• In all versions of the software, you can select Help > Check for 
Handheld OS Update. Select a connected handheld in the Content 
Explorer to activate this option. If the OS on the handheld is not 
current, the dialog indicates that there is an updated version of the 
operating system. Follow the prompts to update the operating 
system.

• In all versions of the TI-Nspire™ software, you can use options 
available in the Documents Workspace:

– Open Content Explorer, select the handheld name, then click  
and select Install OS.

—OR—

– Select Tools > Install Handheld OS.

• Those using teacher versions of the TI-Nspire™ software can use 
options available in the Content Workspace:
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– In the Resources pane, right-click the name of a connected 
handheld, then select Install Handheld OS.

—OR—

– Select the handheld name in the Preview pane, click  in the 
Preview pane, then select Install Handheld OS. 

—OR—

– Right-click the handheld name and select Install Handheld OS.

Completing the OS upgrade
When you select to update the OS on a handheld, the Select Handheld 
OS File dialog box is displayed.

The file displayed for selection defaults to the file type required for the 
selected handheld.

1. Select the OS file:

• If you are upgrading a TI-Nspire™ CX handheld, select 
TI-Nspire.tco

• If you are upgrading a TI-Nspire™ CX CAS handheld, select 
TI-Nspire.tcc

• If you are upgrading a TI-Nspire™ handheld, select TI-Nspire.tno

• If you are upgrading a TI-Nspire™ CAS handheld, select 
TI-Nspire.tnc

2. Click Install OS to download the OS and update the handheld. The 
confirmation message “You are about to upgrade your handheld 
operating system. Any unsaved data will be lost. Do you want to 
continue?” is displayed.
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3. Click Yes to continue. The Installing OS dialog opens indicating the 
progress of the download. Do not disconnect the handheld.

4. When the download is complete, the Information dialog opens 
indicating that the OS file has been successfully transferred to the 
handheld. You can disconnect the handheld.

5. Click OK. The updated operating system is installed on the handheld. 
When the update is complete, the handheld reboots.

6. On the handheld, follow the prompts to:

• Choose a preferred language

• Select a preferred font size

7. When the Welcome screen opens, click OK. The Home screen is 
displayed.

Transferring the Operating System from another handheld
Note: You cannot transfer the OS on a TI-Nspire™ handheld to a 
TI-Nspire™ CX handheld and you cannot transfer the OS on a CAS 
handheld to a non-CAS handheld. The operating systems are not the 
same and are not interchangeable.

To transfer the OS from one handheld to another:

1. Ensure any open documents on the receiving handheld are closed.
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2. Connect the two handhelds using a USB mini-B to mini-B USB cable.

3. On the sending handheld, select My Documents from the Home 
screen.

4. Press b, then select Send OS.

On a TI-Nspire™ handheld, press b.

5. On the receiving handheld, the message, “You are receiving an OS 
Upgrade. Unsaved changes will be lost. Would you like to continue?“ 
is displayed along with Yes and No response buttons. Select Yes to 
receive the OS upgrade. 

• If Yes is not selected within 30 seconds, the handheld 
automatically responds with No, and the transmission is cancelled.

• It is important to save and close all open documents before 
performing an OS Upgrade. Continuing with an OS Upgrade on a 
handheld with an open, unsaved document will cause the loss of 
that data. 

6. While the upgrade is in progress, the following messages are 
displayed on the receiving and sending handhelds:

• “Receiving OS. Do not unplug cable.”

• “Sending OS. Do not unplug cable.“

7. After the transfer completes, the sending handheld receives a 
completion message and you can unhook the cable. The OS is 
automatically installed on the receiving handheld. During the 
installation process, the “Installing OS <version number>” message is 
displayed on the receiving handheld.

8. When the installation is complete, the “OS <version number> has 
been installed. Handheld will now restart.” message is displayed. The 
restart is initiated. If the sending handheld is still attached to the 
cable, the successful transmission message remains displayed on that 
handheld’s screen.
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Important:
• For each receiving handheld, remember to back up information as 

necessary and install new batteries.

• Be sure the sending handheld is on the Send OS screen. 

Upgrading the OS on multiple handhelds
In the classroom, use the TI-Nspire™ Docking Station to upgrade the OS 
on multiple handhelds at the same time.

In the teacher versions of the TI-Nspire™ software, you can transfer files 
from the computer to multiple handhelds from the Content Workspace. 
See Using the Content Workspace for more information about 
transferring files to connected handhelds.

OS Upgrade Messages
This section lists the information and error messages that can be 
displayed on handhelds during an OS Upgrade. 

Shown on: Message and Description

Sending handheld

This message indicates that the receiving handheld 
does not have enough memory available for the 
new OS. The space requirement is shown so you 
know how much memory must be cleared for the 
new operating system. Files can be moved to a 
computer for storage to free the necessary space.

“Receiver does not have 
enough storage space. Make

<xxxK> available.“
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Sending handheld

This message indicates that the batteries in the 
receiving handheld need to be replaced. Send the 
OS Upgrade once the batteries are replaced. 

Sending handheld

This message indicates that the receiving handheld 
has a newer OS version than the one being 
transmitted. You cannot downgrade an OS.

Sending handheld

This message indicates that the receiving handheld 
refuses the upgrade. 

Sending handheld

This message indicates that the transfer is 
complete and it is safe to unplug the cable from 
the sending handheld.

Shown on: Message and Description

“Receiver must change
batteries before upgrading
the OS.“

“Receiver has a newer OS 
and cannot load this OS.“

OK

“Upgrade not accepted by
receiver.“

OK

“OS has been transferred. 
You can now unplug.“

OK
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Sending handheld

This message, along with a progress bar, is 
displayed while the OS Upgrade is being 
transferred. 

Both handhelds

The sending and/or receiving handheld is not 
properly connected. Reinsert the cable into each 
handheld, then try the transmission again.

Receiving 
handheld

This message is displayed when an OS Upgrade is 
about to begin. If you do not select Yes within 30 
seconds, the system automatically responds with 
No.

Shown on: Message and Description

“Sending OS. Do not 
unplug cable.“

“Transfer failed. Check cable
and try again.“

OK

“You are receiving an OS
Upgrade. Unsaved changes
will be lost. Would you like

to continue?“

Yes No
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Receiving 
handheld

This message, along with a progress bar, is 
displayed while the OS Upgrade is being 
transferred.

Receiving 
handheld

This message is displayed when the transfer is 
complete. It is shown to keep you informed of the 
handheld’s status.

Receiving 
handheld

This information message displays briefly before 
the handheld automatically reboots. 

Receiving 
handheld

An error occurred during the transmission, and the 
installation was corrupted. The handheld will 
reboot. After the reboot, reinstall the OS Upgrade.

Shown on: Message and Description

“Receiving OS. Do not 
unplug cable.“

“Installing OS.“

“OS has been installed.
Handheld will restart.“

OK

“Install was corrupted.
Handheld will reboot. You 

will need to retry OS 
upgrade.“

OK



Using Keyboard Shortcuts 99

Using Keyboard Shortcuts

Keyboard shortcuts
Use the following keyboard shortcuts to perform common functions. You 
can also perform all shortcuts performed by selecting options from 
menus.

Getting Help

Open Hints / μ

Editing Text

Cut / X 

Copy / C 

Paste / V 

Undo / Z

/ d

Redo / Y

g d

Toggle approximate and exact results / ·

Change key to include appropriate accent ;

Inserting Characters and Symbols in a document

Display character/symbol palette / k 

Underscore / _ 

Display math template palette t 

Backslash ( \ ) g p

Manual data capture point / ^

Clear / .

Caps Lock / g

Store / h
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Square brackets / (

Curly brackets / )

Display Trig symbol palette μ

Equals symbol =

Display pi symbols palette 
(p, à, q, and so on), 

¹

Display equality/inequality palette
(>, <, É, Ç, Å)

/ =

Display marks and letter symbols palette 
(? ! $ ° ' " : ; _ \)

º

Square root / q

log / s

ln / u

ans / v

Managing Documents

Open document menu ~

Open document / O

Close document / W

Create new document / N 

Insert new page / I 

Select application / K

Save current document / S 
/»

Navigation

Top of page / 7

End of page / 1

Page Up / 9
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Page Down / 3

Up a level in the hierarchy / £

Down a level in the hierarchy / 6

Context menu for selection b

Extends selection in direction of arrow g Any 
arrow

Navigating in Documents

Displays previous page / ¡ 

Displays next page / ¢ 

Displays Page Sorter / £ 

Exits Page Sorter / 6

Switch between applications on a split page / e

Moves focus backward within page g e

Wizards and Templates

Add a column to a matrix after the current column g @

Add a row to a matrix after the current row @

Integration template g + 

Derivative template g - 

Math template palette  t or / ;

Fraction template / p

Modifying Display

Increase contrast / + 

Decrease contrast / - 

Power off / c 

Using Application-Specific Shortcuts

Select all in Notes or Program Editor / A
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Check syntax and store (in Program Editor) / B

Insert Data Collection console / D

Find (in Program Editor) / F

Hide/Show Entry Line (in Graph or Geometry)

Go To (in Lists & Spreadsheet, Program Editor)
/ G

Find and Replace (In Program Editor) / H

Insert math expression box (in Notes) / M

Open the Scratchpad »

Recalculate (in Lists & Spreadsheet) / R

Add Function Table (in Lists & Spreadsheet, Graph, and 
Geometry)

/ T

Group/ungroup / 4 / 

/ 6
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Appendix: Service and Support

Battery Precautions 
Take these precautions when replacing batteries. 

• Do not leave batteries within the reach of children. 

• Do not mix new and used batteries. Do not mix brands (or types 
within brands) of batteries.

• Do not under any circumstances use rechargeable AAA batteries in 
your handheld. 

• Install batteries according to polarity (+ and - ) diagrams. 

• Properly dispose of used batteries immediately. 

• Do not incinerate or dismantle batteries.

Disposing of Batteries
• Do not mutilate, puncture, or dispose of batteries in fire. The 

batteries can burst or explode, releasing hazardous chemicals. 
Discard used batteries according to local regulations.

Texas Instruments Support and Service

For general information 
For more information about TI products and services, contact TI by e-mail 
or visit the TI Internet address.

Service and warranty information
For information about the length and terms of the warranty or about 
product service, refer to the warranty statement enclosed with this 
product or contact your local Texas Instruments retailer/distributor.

E-mail inquiries:  ti-cares@ti.com

Home Page: education.ti.com

mailto:ti-cares@ti.com
http://education.ti.com
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adding to text 50
adjusting contrast 5
application

menu 35
applications

adding to a document 30
multiple 31
swapping 34

Automatic Power Down™ (APD™) 6

B
backup

handheld files to another 
handheld 84

batteries
disposing of 56
rechargeable 67
TI-Nspire/TM Rechargeable 

Battery 67

C
cables 73
Calculator history

viewing 17
cancelling a file transfer 76
Catalog 13

inserting items from 13, 15
catalog 62

inserting commands 47
using 46
using wizards 48

characters
international language 50
special 49

class
logging in 51

clearing
the Calculator history 18

connecting
two handhelds 73

contact information 103

contrast
adjusting 5

conventions
file naming 45

copying
items from Calculator history 18

copyright statement ii
customer support and service 103

D
default settings

restoring 62
deleting

documents 84
documents

browsing files 43
closing 46
copying pages to 40
creating 28
deleting 45, 84
duplicating 45
managing 43
receiving from another user 76
recovering deleted 46
renaming 44
saving 28
selecting for transfer 75
structure 27
transferring 74
viewing pages 38

E
editing

math expressions 19
entering math expressions 12
errors

sending folders 78
evaluating

math expressions 12
evaluating a math expression 14
expressions

copying from Calculator history 
18

editing 19
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entering and evaluating 12
entering from a template 14
entering with a wizard 15
selecting in Calculator 19

F
file naming conventions 45
file transfers

common error messages 79
files

backing up 84
browsing 43
naming conventions 45
transferring 74
transferring to another 

handheld 75
finding upgrades 90
folders

creating 44
deleting 45
duplicating 45
renaming 44

font size
choosing 4

G
General Settings 59

restoring 62
Graphics & Geometry settings 63

restoring 66

H
handheld

adjusting contrast 5
connecting to another 73
hints 10
home menu 6
keys 2
screen 8
turning on for the first time 3
updating the operating system 

89
hints 10
history

deleting Calculator history 18
viewing Calculator 17

history, Calculator
copying from 18

Home menu 6
home menu 6

I
inserting items from the Catalog 13
items

insert from catalog 13

K
Keyboard shortcuts 99
keypad 2

L
language

changing 57
choosing 4
international characters 50

layout
page, choosing 31
page, custom 32

logging in to class 51

M
math expressions 49

editing 19
entering and evaluating 12
selecting in Calculator 19

math templates 49
memory

checking 83
freeing 84
resetting 86

menu
context 36

menus
home 6

O
Operating System

transferring 93
upgrading 91

operating system
updating 89
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Operating System upgrades
error messages 95

operating system upgrades 90
OS
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OS upgrades
error messages 95

P
page

reordering pages in document 
38

Page Sorter 38, 43
pages 27

adding to problems 42
copying to another document 40
copying to another problem 39
moving through documents 42
multiple applications 31
reordering 43
reordering in problems 38, 39, 40
viewing in documents 38

power sources, power sources
priority 56

problems 27
adding pages 42
adding to pages 37
copying 40
copying pages to other 39
deleting 41
pasting 40
renaming 41

R
receiving

documents from another user 76
recharging

handhelds 55
TI-Nspire/TM Rechargeable 

Battery 55
renaming

folders or documents 44
problems 41

reordering pages in a problem 38, 
39, 40

restoring

Graphics & Geometry settings 66
results

copying from Calculator history 
18

reusing
items from Calculator history 18

S
saving Scratchpad contents 24
Scratchpad 6

saving 24
selecting

expressions in Calculator 19
sending folder errors 78
service and support 103
Settings & Status

general 59
Graphs & Geometry 63
opening 57

shortcuts
keyboard 99

software
upgrading 51

support and service 103

T
templates 49

math expressions 49
using 14

TI-Nspire/TM tools 46
TI-Nspire™ Navigator™ wireless 
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attaching to handheld 70

touchpad
using 5

transferring
documents to another handheld 

74
files to another handheld 75

transferring files 74
rules 75

transfers
cancelling 76

U
Upgrading the OS 91



108

USB cables 73
Using USB cables 73

V
variables

creating 46

W
wireless cradle

connecting to handheld 70
wizard

entering expressions with 15
wizards

using 48
work areas 27

multiple 31


	Important Information
	FCC Statement
	FCC Statement

	Getting started with the TI-Nspire™ CX handheld
	About CAS
	TI-Nspire™ CX handheld keys
	Preparing the TI-Nspire™ CX handheld for use
	Charging the handheld

	Turning on the TI-Nspire™ handheld for the first time
	Using Automatic Power Down™
	Choosing a language
	Choosing a font size

	Adjusting the brightness of the backlighting
	Using the TI-Nspire™ Touchpad
	Understanding the Scratchpad
	Using the Home screen
	Home screen options

	The TI-Nspire™ handheld screen
	Using Hints

	Using the Scratchpad
	Opening and closing the Scratchpad
	Calculating with the Scratchpad
	Entering simple math expressions

	Inserting items from the Catalog
	Using an expression template
	Inserting expressions using a wizard

	Viewing the history
	Copying a history item to the entry line
	Clearing the history

	Editing Scratchpad expressions
	Inserting elements into the entry line
	Selecting part of an expression

	Graphing with the Scratchpad
	Viewing the function table
	Changing the appearance of the axes
	Tracing a graphed function
	Finding points of interest

	Working with variables in the Scratchpad
	Saving the Scratchpad contents
	Clearing Scratchpad contents

	Working with documents on the CX handheld
	Opening a document
	Creating a new document
	Saving a document
	Working with applications
	Adding an application
	Using multiple applications on a page
	Grouping applications
	Ungrouping pages

	Using the Application menu
	Using the Application menu

	Context menus
	Using the Context menu

	Working with problems and pages
	Adding a problem to a document
	Viewing and reordering pages in a document
	Viewing multiple pages with the Page Sorter
	Opening the Page Sorter from a document
	Reordering pages in a problem
	Copying a page to another problem
	Copying a page to another document

	Copying, pasting, and deleting problems
	Copying and pasting a problem
	Deleting a problem

	Renaming a problem
	Adding a page to a problem
	Moving through pages in a document
	Managing documents
	Browsing files in My Documents
	Renaming folders or documents
	Creating folders
	File and folder naming conventions
	Duplicating documents and folders
	Recovering deleted documents

	Closing a document
	Understanding the TI-Nspire™ tools
	Creating TI-Nspire™ variables
	Using the catalog
	Using wizards
	Using special characters or math templates
	Entering international language characters


	Working in a TI-Nspire™ Navigator™ Teacher Software classroom
	Logging in to class
	TI-Nspire™ handheld login status icons

	Pausing a class session
	Responding to Quick Poll questions
	Answering a Quick Poll question
	Responding to different question types
	Clearing your answers


	Configuring the TI-Nspire™ CX handheld
	Checking battery status
	Recharging the handheld
	Recharging your battery from a computer
	Understanding the priority of power sources
	Disposing of used batteries safely and properly

	Changing handheld settings
	Opening the Settings menu

	Changing the preferred language
	Customizing the handheld setup
	Changing Handheld Setup options

	Customizing General settings
	Changing the default General Settings
	Changing General Settings in a TI-Nspire™ document
	Restoring General Settings

	Customizing Graphs & Geometry settings
	Changing default Graphs & Geometry Settings
	Changing Graphs & Geometry settings in TI-Nspire™ documents
	Restoring Graphs & Geometry Settings

	Viewing handheld status
	Opening the Handheld Status screen

	Replacing TI-Nspire™ Rechargeable Battery
	Using wireless communication hardware
	Attaching a wireless adapter to a handheld
	Attaching a wireless cradle to a handheld


	Connecting handhelds and transferring files
	Connecting handhelds
	Using USB cables
	Connecting two TI-Nspire™ handhelds with the mini-USB cable
	Connecting the TI-Nspire™ handheld to a computer

	Transferring files to and from handhelds
	Rules for transferring files and folders
	Sending a document or folder to another handheld
	Receiving a document or folder
	Canceling a transfer

	Transferring files between computers and handhelds
	Using the Save to Handheld option

	Handling errors resulting from sending folders
	Common error and notification messages


	Memory and file management
	Checking available memory
	Freeing memory
	Deleting files from the handheld
	Backing up files to another handheld
	Transferring files to a computer

	Resetting the memory

	Updating the handheld operating system
	What you need to know
	Before you begin

	Finding operating system upgrades
	Checking for handheld OS updates

	Upgrading the Operating System
	Completing the OS upgrade
	Transferring the Operating System from another handheld
	Important:

	Upgrading the OS on multiple handhelds
	OS Upgrade Messages

	Using Keyboard Shortcuts
	Keyboard shortcuts

	Appendix: Service and Support
	Battery Precautions
	Disposing of Batteries

	Texas Instruments Support and Service
	For general information
	Service and warranty information


	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


